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Introduction 
 
The Form EIA-23L, “Annual Report of Domestic Oil and Gas Reserves,” gathers and summarizes credible and 
timely data regarding proved reserves and production of crude oil, natural gas, lease condensate and other 
related matters. The government uses the resulting information to develop national and regional estimates of 
proved reserves of domestic crude oil and natural gas to facilitate national energy policy decisions. 
 
Each year EIA posts an electronic version of the Form EIA-23L (including form completion instructions) to 
the EIA website: 

 

http://www.eia.gov/survey/#eia-23l 
 

The form and instructions describe who is required to file a Form EIA-23L and provide definitions of the data 
requested. The form last underwent significant changes as of Report Year 2016, and these changes are 
reflected in the Form EIA-23L Reserves Information Gathering System (RIGS). For Report Year 2020, the 
process for importing prior-year data has changed; these new steps are described on page 4 of this guide. 
 
RIGS provides respondents with an efficient and effective means for filing the form using a personal 
computer. It is available for download: 
 

http://www.eia.gov/survey/form/eia_23l/rigs.cfm 
 

You must submit your data via Secure File Transfer, an industry standard method for sending information 
over the Internet using encrypted processes (see section titled “Create Submission File” for detailed 
instructions). This User’s Guide provides instructions for using RIGS. 
 
If you require any assistance in installing or running RIGS, call EIA at 1 (800) 879-1470 between 8:30 a.m. 
and 5:00 p.m. EST. 
 

Hardware / Software Requirements 
 
The minimum hardware requirements needed to install and use RIGS are: 

 

o An IBM-compatible computer 
 

o Windows operating system (7 or higher) 
 

o A hard drive with at least 20 megabytes of free disk space 
 

o  Internet connection and browsing software (Chrome, Firefox, etc.) to download the 
installation program and submit via Secure File Transfer 
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Installing the RIGS Software 
 

To install the EIA-23L RIGS software on your PC: 
 

1) Open your Internet browser (Internet Explorer, Firefox, etc.), and go to: 
 

http://www.eia.gov/survey/form/eia_23l/rigs.cfm 
 

2) Click the “Download RIGS Application” link under the “Downloading and Installing” heading. 
This will open the “RIGS Installer” page. 

 
3) Click the Run button. An “Application Run - Security Warning” may be displayed. Click the 
Run button to proceed. 

 
4) The “RIGS 2020 – Installer” box is displayed. From the initial “Welcome” box (shown below), 
click Next. 

 
 
 

5) The next box asks if you have RIGS 2018 or RIGS 2019 already installed on your PC. 
 

 
- If you do not have last year’s version (or the 2018 version), select No and click Next. RIGS 

2018 will then be installed to your PC; follow the prompts to complete its installation. When 
it’s finished, you will be returned to the RIGS 2020 installation screen. 

- If you do have last year’s version (or the 2018 version) on your PC, select Yes and click Next 
to proceed to the next step. 
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6) The next screen asks to point to the folder to which you wish to install RIGS 2020. The default 
folder to which the system will be installed is: C:\RIGS 2020. If you wish to change the directory, 
click the button to the right of the folder name, as shown below (note that the text showing the 
default destination folder – C:\RIGS 2020 – is shown in the circled box): 
 

After entering the desired location for RIGS in the highlighted box above (or accepting the 
default location), click the Next button to continue the installation. 

 
7) The next box says it’s creating the 2020 folder. Click Next. 

 
8) Next, a shortcut to RIGS is created. Click Next. RIGS is then installed; click the Finish button 
to exit the Installer. 
 

 
 

 You are now ready to run the RIGS 2020 program! 
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Using the EIA-23L Reserves Information Gathering System (RIGS) 
 

From your Windows Desktop, click the Start button, then the Programs button. Select the EIA Applications 
item, and then click RIGS 2020. The following introduction screen is displayed: 
 

 
NEW FOR REPORT YEAR 2020: The import of last year’s RIGS data, which has, in prior versions, been 
performed via the “Import From File” button on the RIGS Main Menu, must now be performed from this 
screen. This process is described in the section below. 
 
Initial Data Import from Last Year’s RIGS Submission File 

 
This is useful if you have data for a large number of counties to enter manually. Importing last year’s file will 
move last year’s Total Proved Reserves data (from column H of the 2019 EIA-23L data) to this year’s Total 
Proved Reserves (column A).  If you are using the same PC for filing RIGS as you used last year, the import 
file should be located in the previous year’s \RIGS yyyy\data directory, where yyyy is the four-digit previous 
filing year. 
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If you wish to import your data from last year, click Import Last Year’s Data from the RIGS 
Introduction screen, as shown below: 
 

 
(NOTE: If you do not wish to import last year’s data, click the Continue button below the Import 
Last Year’s Data button, to open the RIGS program and view the Main Menu. Proceed to page 
7 of this manual for further instructions.) 
 
After you click the Import Last Year’s Data button, the following screen is displayed: 

 
 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Import From File - Import File Name 
 
In the bottom right field (shown above), select “Last Year’s Data (Respondent.MDB).” Its location on 
your hard drive depends on where you loaded the RIGS system the previous year. 
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In the “File Name” field, select last year’s “Respondent.MDB” file name, containing the previous year’s 
filing data. 
 
Click the Open button. A confirmation box is displayed, informing you that the import is complete. (You may 
receive an error message if the file is not in the correct format.)  On the import confirmation box, click OK 
and the RIGS Main Menu is displayed. When you click the “Select Company” option, the company or 
companies from last year’s filing should appear in the “Company Selection Screen.” All data entered in the 
previous year, now grouped by county, will appear when you select the “View/Modify Existing Counties” on 
the Schedule A tab, along with the Total Proved Reserves data for the prior year. 
 
After completing this initial import, you are ready to enter data for the current year. The introduction screen 
is displayed again; click the Continue button to proceed to the RIGS Main Menu. 
 

 
 

Note that you may uncheck the box at the bottom of the screen to skip this screen when you open RIGS, 
going forward. 
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The RIGS Main Menu Screen 
 

After you have successfully imported last year’s data (or clicked Continue) from the RIGS Introduction 
screen, the Main Menu Screen of RIGS is displayed, as shown below: 

 
  
 
 
 
 
 
 
 
 

Click the 
“Home” tab at 

any time to 
return to the 
Main Menu 

Screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Main Menu Screen 
 

 
 

The four main options available in RIGS are accessed via this menu: 
 

1) Select Company: Click this button to add a company to RIGS, select a current company for 
editing, or remove a company from RIGS. 

 
2) Print Forms: Click this button to print a copy of the current version of the active company’s 
EIA-23L form. 

 
3) Create Submission File: Click this button to generate a file containing all entered county data 
for submission to EIA. 

 
4) Import from File: Click this button to load prior-year data, which will now be grouped by 
county, or an externally-created data file, into RIGS. 

 
Each option is described in the sections that follow. 
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Select Company 
 

After clicking the Select Company button on the Main Menu Screen, the following Company Selection 
Screen is displayed: 

 
 

Tabs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Company - Company Selection Screen 
 
 
On this screen, there are three tabs, representing the three options available. You may select a company to 
edit (Select), add a new company to RIGS (Add) or delete a company from your current list of EIA-23L 
companies (Remove Company). 

 
 
 
 

“Select” List: This list shows the name and ID number of each company for which 
the respondent intends to submit EIA-23L data. Companies can be easily added 
and removed from this list. Once the list is completed, the user can select any 
company to edit or validate from the “Select” List. 
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Add a Company 
 

To add a company to your list of current companies, follow these procedures: 
 

1) Click the Select Company button from the Main Menu Screen. 
 

2) If you have not yet added any companies to RIGS, go to step 3 (the Add tab is the default tab 
displayed).  If you have already added one or more companies but need to install another 
company, click the Add tab, as shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Company - Add tab 
 
 

3) After the Add tab is clicked, the following screen is displayed: 

 
Select Company - Add 
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4) The cursor should appear in the EIA ID Number box; type in the ID number of the new 
company. If you do not know the company’s ID number, contact EIA at 1 (800) 879-1470 
—do not make one up! 

 
5) Tab to the Company Name box, and type in the new company’s name. 

 
6) Click the OK button to add the new company to your “Select” List. The Cover Page Part I 
screen is displayed, and you are ready to enter data for the new company. This new company 
will also be added to the “Select” List (if you wish to edit, print, or submit it at a later time). 

 

 

Select a Company 
 
To enter data for a company that you have already added to the EIA-23L respondent database, follow 
these procedures: 
 

1) Click the Select Company button from the Main Menu Screen. 
 

2) Click the Select tab. A list of companies that have already been added is displayed, as shown 
below: 

 
 
 

 
Select Company - “Select” tab 

 

 
3) Scroll down the list to locate the company you wish to edit. Once you’ve located the desired 
company, click the company name, then click the OK button. The selected company is then 
displayed in the Cover Page Part I screen, ready for data editing. 



Form EIA-23L Reserves Information Gathering System (RIGS) User’s Guide February 2021 

11 

 

 

 

Remove Company 
 
To remove a company from the “Select” List, follow these procedures: 
 

1) Click the Select Company button from the Main Menu Screen. 
 

2) Click the Remove Company tab. A list of current companies is displayed (identical to the list 
displayed under the “Select” tab). 

 
3) Scroll down the list to locate the company you wish to remove from the “Select” List, and click 
the company name, then click the OK button. 

 
4) A confirmation box is displayed, asking if you are sure you wish to delete the company. Click 
the Yes button to confirm removal of the company, or No to cancel the removal process. If you 
click Yes, the selected company is removed from the “Select” List, and the Remove Company 
screen tab is still displayed, in case you wish to remove more companies. 

 
Note:  If you decide you removed a company by mistake, you must click on the “Add” tab and 
“re-add” the deleted company, and re-enter any data for that company. 
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Enter Data 
 

After you have added at least one company to your “Select” List, you may begin to enter data for that 
company. To begin updating company data, follow these procedures: 

 
1) Click the Select Company box from the Main Menu Screen. 

 
2) The default tab selection is “Select.” Single click on a company in the “Select” List box, then 
click the OK button to enter data for that company. The Cover Page Part I screen is displayed, as 
shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Enter Data - Cover Page Part I 
 
 
 
 
 
 
 
 
 
 
 

Note 
 
The currently-active company’s EIA identification number is displayed constantly at the bottom of the 
screen (as indicated above). 

EIA 
Identification 

Number 
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The three sections that follow describe the three screens on which data can be entered. Click on the tabs at 
the top of the screen to access each: Cover Page Part I, Cover Page Parts II/III, and Schedule A. 
 

Cover Page Part I 
 

This tabbed page is used to enter company identification information. After clicking Select Company from 
the Main Menu Screen, click on a company to edit from the “Select” List. Follow the procedures below to 
add/edit company identification data: 

 
1) After selecting a company to edit, the cursor will be automatically positioned on the first input 
data entry box of the Cover Page Part I. After entering or modifying identification data, including 
primary and secondary contact information, you can press the Enter or Tab key to continue to 
the next input data entry box. Press the Shift + Tab key combination to move the cursor to the 
previous input data entry box. 

 
2) Enter any applicable company identification information on the Cover Page Part I. In the 
middle of the screen, you are asked “Was your company an oil and gas field operator during 
calendar year 2020?”  Click the appropriate radio button: 

 
- If you select “No,” you only need to fill in Parts I, II and III in RIGS. No Schedule A 

company data can be entered if “No” is selected here. 
 

- If you select “Yes,” you must complete Parts I, II, III and Schedule A, which includes 
county data.  If you have Schedule A data to report for the current year, you must 
select “Yes” here. 

 
3) Check any applicable boxes in the “Company Status, Name, and Address Change or 
Correction”: 
- Confirm that the current name/address is information is correct by checking the first 

box.  
- If your company was sold or merged with another company during the report year, 

click the second box, and type in the company name, address, and contact 
information for the company to which yours was sold or merged with, in the “Sold to or 
Merged with Company Information” box that is displayed when you check the box. 

 
  

 

 

 
 
 
 
 
 
 
 
 
 
 

- If your company went out of business during the report year, check the third box.  Enter the 
company name, address, and contact information of the company that has taken over your 
accounts in the “Company Information that Took Over Accounts” box that is displayed when 
you check the box. It looks very similar to the “Sold to or Merged with Company Information” 
box shown above. 
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Note:  If you need to edit the company information for either the “sold or merged” or “taken over 

accounts” company, click the small Edit button that appears after you have entered 
information in either of these categories, as shown below:  

 
 
 

 
 
 
 Also, note that only one of the two boxes, “Company was sold or merged” or “Company went 

out of business,” may be selected for your company. If you try to select both, the first one 
you selected will revert back to unchecked. 

 
4) The final section on the Cover Page Part I screen describes two scenarios; please check the 
applicable box if either applies to your company: 
 
- “You acquired an oil and gas operating company.” If your company purchased an oil and gas 

operating company during the report year, the acquired company’s information should be 
entered in the dialog box that is displayed when you check the applicable box. Include the 
acquired company’s name, the states in which the acquired company operates, and the 
approximate date operations transferred to your company. If the acquired company operates 
under a different name from your company, include the new name as well. Click OK to save 
your information. A sample is shown below: 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Note: This box is for reporting entire companies or divisions that you have acquired. Report 

any individual reserves assets sold and purchased throughout the year as usual on Schedule 
A (columns D and E). 
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- “You are completing this for a subsidiary or affiliated company.” If your company has different 

divisions or affiliated companies that report as one organization on the EIA-23L form, list the 
companies in the box that is displayed when you check this option. Click OK to save your 
information. A sample is shown below: 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Cover Page Parts II/III 

 
This tabbed page is used to enter parent company information and your approval.  After clicking Select 
Company from the Main Menu Screen, click on a company to edit from the “Select” List. Follow the 
procedures below to add/edit parent company identification data and/or approval data: 

 
1) Click the Cover Page Parts II/III tab at the top of the screen, as shown below: 

 
 
 
 
 
 
 
 
 

Enter Data - Cover Page Parts II/III Tab 
 

2) The Cover Page Parts II/III tab screen is displayed. Fill in Part II as described below: 
 

If your company is controlled by a parent company, click Yes and fill in the parent 
company’s name and address. 

 
If your company is NOT controlled by a parent company, click No and proceed to Part 
III, Approval. 
 
Type in any applicable comments in the Comments box. 

 
3) In Part III, Approval, enter the name of the Contact Person and his/her title in the boxes 
provided. 
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Schedule A 
 

This tabbed page is used to enter county information and data. After clicking Select Company from the 
Main Menu Screen, click on a company to edit from the “Select” List. Follow the procedures below to add or 
delete a county for that company, or to edit county data: 

 
1) Click the Schedule A tab at the top of the screen, as shown below: 

 
 
 
 
 
 
 
 

Enter Data - Schedule A Tab 
 

Notes:  A message may appear, alerting you that there is no need to fill in Schedule A data, because you 
have answered “No” to the question, “Was your company an oil and gas field operator during the current 
report year?” in Part I. You cannot access the Schedule A Tab Screen unless you have already selected 
“Yes” for that question on the Cover Page Part I tab screen. 

 
If you have not yet entered any counties, the “Add/Delete Counties” box is displayed first, as shown on the 
next page, requiring you to enter at least one county before displaying the “Schedule A Tab Screen.” 

 
2) The Schedule A Tab Screen is displayed, as shown below: 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter Data - Schedule A Tab Screen 
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In order to enter data on this screen, you must first select a county for the company. This can 
be done by one of two methods: 

- Add a county 

- Modify a county 
 

Add a County 
 

If the county that you wish to update has not yet been added for the company you’ve 
selected, click the Add / Delete Counties button, as shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter Data - Add / Delete Counties Button 
 
 

The following Add / Delete County Maintenance Screen is displayed: 
 

 
Enter Data - Add / Delete County Maintenance Screen 
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First, you must select the state in which the county resides. You may type in the state’s 
two-character code, or select from the drop-down list (as shown on the previous screen). If you 
type in the state code manually, click the Retrieve County button (just to the right of the state 
code box) to display a list of counties for that state; if you select the state code from the drop-
down list with the mouse, the list of counties for that state is displayed automatically. 

 
An example of a county list is shown below: 

 

 
Enter Data - County List 

 
 
 

Note: If the county you wish to add does NOT appear on this list (only counties 
that have historically filed reserves data are shown in the drop-down list), click 
the Click here if County is not in list button (located to the right of the County 
Name box). The county list disappears, and you must then type in the following 
information for the new county: 

 
•
 

County Name  

County Code 

Subdivision Code

 
 

It is important to note that this is the only time you can change these identification 
fields. After a county is added, these data entry boxes are read-only and cannot 
be edited. After entering the appropriate data in the boxes listed above, click the 
OK button to add the county to the current company. County Name is required; 
all other boxes can be left blank if you’re unsure what to enter. 

 
 
 

If the desired county is located on the county list (scroll up and down by clicking on the up and 
down arrows along the right side of the county list), click on that county name. The county’s 
name, subdivision code, and county code are automatically filled into the Add /Delete County 
Maintenance screen, as shown on the next page.
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Enter Data - County Selected 

 
Note that type code is not shown on this screen. Type code is considered a MANDATORY field, and must 
be selected on the Schedule A main screen after the county has been added. 
 
After the desired county’s data are displayed in the Add / Delete County Maintenance Screen, click the 
OK button, as shown above. The selected county’s data are then displayed on the Schedule A Tab 
Screen, as shown below:  
 

  
 

 
 
 
 
 
 
 
 

  
 
 
 
 

 
 
 
 

  
 
 

Enter Data - Schedule A:  County Data 
 
The type code drop-down menu is automatically displayed if the selected county does not have a previously 
selected type code. The first thing you must do on this screen is select a type code from this drop-down 
menu, highlighted above. Select the description that best describes the reservoir in which the reserves lie. 
Type code options include conventional, coal bed, low permeability, and shale. If you aren’t sure about the 
nature of the reservoir, select “Unknown.” As of Report Year 2018, Coalbed is no longer accepted as a 
Type Code. If you previously entered Coalbed as the Type Code for the selected County, please 
select “C” for Conventional. Also, “Shale” only appears on the Type Code drop-down menu if the 
selected County reported Shale as its Type Code in the past. Most counties, including the sample 
shown above, will not include Shale as an option in this latest version of RIGS.  
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Note that if you do not select a type code, and then attempt to click another tab (Home or Cover Page), 
the Type Code drop-down will again be displayed, until you select one of the listed types. 

 
After selecting the type code, continue by entering the appropriate data in each box. Use the Tab (or 
Enter) key to move to the next box, or use the mouse to move around the screen. 

 

Enter Schedule A Data 
 

Recent updates to the RIGS Schedule A data entry process include: 
 
o If you report Sales data (in column D) or Acquisitions data (in column E), an edit check will 

require that you add a footnote identifying all operators involved in the sale or acquisition, and 
the month of the transaction as it was reported to state agencies. 
 

o Data thresholds were added for Extensions and Discoveries. If you enter data higher than these 
values shown below, for the specified line numbers, an edit check is triggered when you run the 
RIGS “Verify Data” option: 

 
- Line 12, Crude Oil: If value entered in cell F (Extensions and Discoveries) is greater than 

10,000 Mbbl, a footnote is required. 
- Line 13, Associated-Dissolved Gas: If value entered in cell F (Extensions and Discoveries) 

is greater than 25,000 Mmcf, a footnote is required.  
- Line 14, NonAssociated Gas: If value entered in cell F (Extensions and Discoveries) is 

greater than 25,000 Mmcf, a footnote is required.  
- Line 15, Lease Condensate: If value entered in cell F (Extensions and Discoveries) is 

greater than 5,000 Mbbl, a footnote is required.  
 

Where numeric values are expected: 
 

o All data entry boxes must have positive values 
 
o Enter the appropriate number, or leave the data entry box blank. 
 
o Use the right arrow key or the left arrow key to move within the active data entry box. 
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o For Items 12, 13, 14, and 15, the following calculation is used to determine the Total 

Proved Reserves (Column H): 
 

Column A + B - C - D + E + F - G = H  
 

As you enter data into any of the columns A through G, the Total Proved Reserves field in 
Column H will be auto-filled with the calculated total, using the formula above. The four 
Column H data fields cannot be edited, as they are automatically calculated, as shown below.  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
As you enter data in any 
of the Row 12 through 
15 data fields.... 

...the value in 
Column H is 
automatically 
calculated and 
filled. It cannot be 
edited manually by 
the user. 

Enter Data - Schedule A:  Calculated Total Reserves 
 

Auto-calculated data in Column H, Total Proved Reserves, cannot be changed 
manually by the user. Fields 12-H, 13-H, 14-H, and 15-H are read-only. 

 
o Click the Save button in the upper left portion of the screen to save your work at any time. 
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Delete a County 
 
If you wish to delete a county from your RIGS database, click the Add/Delete Counties button. 
 
Click the Delete County tab (on the right of the screen) to view all counties that have been added to the 
currently-selected company. Select the county you wish to delete, then click the OK button. A confirmation 
box is displayed, asking if you are sure that you wish to delete this county. Click the Yes button to delete the 
county (or No to return to the Add/Delete County Maintenance Screen). 
 
View/Modify Existing Counties 
 
If you wish to view or edit data for a county which has already been added to the currently-selected company, 
click the View/Modify Existing Counties button. A  list  of  all  counties that  have  been  added  to  the 
currently-selected company is displayed. Click on the county that you wish to edit, and its Schedule A data 
are displayed. Follow the data editing procedures in the “Enter Schedule A Data” section of this document 
to change the data you have already entered for the selected county. 
 
Add a Footnote 
 
If you wish to add a footnote (Schedule B) for any Schedule A data you enter, follow these procedures: 
 

1)  Click the Footnote button, as shown below: 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add a Footnote - Footnote Button 
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2)  The Footnote box is displayed, as shown below: 

 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

Add a Footnote - Footnote Box 
 

3)   In the Footnote box, type in the item number and column letter (if applicable) into the 
appropriate boxes, then type in the footnote in the area at the bottom of the box, as shown above. 

 

For example, if you wish to enter a footnote for Nonassociated Gas - Sales, type “14” in the item 
number box (for nonassociated gas) and “D” in the column letter box (for sales). This indicates 
that the footnote applies to that specific data entry box. 

 
4) After typing in the desired footnote, click the OK button. The system retains the footnote and 
it will appear on the hard copy when the “Print Form” option is used. 

 
Modify a Footnote 
 
If you wish to alter a footnote after entering it, follow these procedures: 
 

1) Click the Footnote button on the main screen. The Footnote box is displayed, and footnotes 
can be changed by clicking the Modify tab, as shown below: 

 
 
 
 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 

Footnote Box - Modify Footnotes 

 
 

...and type footnote in this area. 

...and column letter here... 

Type item number for which you 
wish to enter a footnote here... 

Click the Modify tab to change 
an existing footnote. 
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2) A list of all footnotes is displayed (by item number and column letter); click on the footnote you 
wish to edit. The footnote text will appear in the area at the bottom of the Footnote Box, and you may 
edit it as you wish. Be sure to click the OK button when you have completed editing the footnote to 
save your changes. 

 
Delete a Footnote 
 
If you wish to delete a footnote, click the Delete tab (to the right of the Modify tab shown above), and select 
the footnote you wish to delete from the list that is displayed. Click the OK button to delete the selected 
footnote. 

 

Verify Data 
 

After you have entered your data for the county (or counties), it is recommended that you verify 
the form data.  RIGS uses numerous edit checks to assist you in making sure the data you enter 
are correct. To run these edit checks, click the Verify Data button in the upper left corner of the 
screen, as shown below: 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Verify Data - Verify Form Button 
 

1)  A dialog box appears, asking if you want to verify data for the selected county only, or for all 
counties. This box is shown below: 

 
 

 

 
 
 
 
 
 
 
 
Verify Data - Verification Dialog Box 
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If you wish to only verify data for the county currently selected, click Yes. If you 
wish to verify data for all counties you’ve entered, click No. 
 
If you do not wish to verify any counties at this time, click Cancel to return to the 
Schedule A Tab Screen. 

 

2)  After running the Verify Data option, progress messages are displayed, indicating that 
counties are being validated. Once validation is completed, you may receive a message stating 
that no errors have been detected. In that instance, your data are clean and you may proceed to 
send your filing to EIA. However, if errors are found, the following screen is displayed: 

  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Verify Data - Validation Screen 
 

3)  The top portion of the screen shows the results of the validation. See the explanation 
on the next page for details on navigating through the validation process. 
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Verify Data - Navigate 
 

At the top of the screen, the county name is listed, along with the state code, subdivision code, 
county code, and type code. 

 
Next, the edit issue is shown. The reason that the system flagged the data is given, and the data 
value in error is highlighted in the county data area (the lower part of the screen). Thus, you can 
easily correct the errant data. 

 
If flagged data are acceptable to you, you can enter an explanation for the discrepancy in the 
Footnote box. This footnote will automatically be saved to the item and column which have been 
flagged. For example, if an error is flagged for the data in item 12, column A, you may enter a 
footnote when the verification process displays item 12, column A’s edit issue. The new footnote 
will then be “attached” to item 12, column A, when you return to the main data entry portion of the 
Schedule A Tab Screen. For further details, see the “Add a Footnote” section. 

 
Along the bottom of the Verify Form - Navigation screen (shown above) are four buttons: 

 
Previous Edit: Click this button to return to the edit prior to the one currently displayed. 

 

Next Edit: Click this button to display the next edit discovered during verification. 
 

Restart Edits: Click this button to restart the verification process. The Verification 
Dialog Box is displayed -- follow instructions earlier in this section to run the Verify Form 
process.  “Restart edits” is available in case you wish to make changes to county data 
while the “Verify Form - Navigation” screen (shown above) is displayed (county data is 
still viewable and editable in the lower portion of the screen), and you want to verify 
these new updates. 

 

Done: Click this button when you are finished reviewing the edits; the Verify Form screen 
disappears, and the complete Schedule A Tab Screen is re-displayed. 
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There are two tabs that can be clicked while using the Verify Form option: 
 

Navigate: The default option. Click this tab to scroll through the discovered edits using 
the features described above. 

 

List: Click this tab to display the following: 
 

 
 

 
 
 
 
 
 
 

Verify Data - List 
 

The list option displays the first page of the printable version of the “RIGS Error Report,” a list of 
all edits discovered for the current company’s counties. 

 
Use the horizontal and vertical scroll bars along the right side of the list box to view the first page 
of the report. 

 
Click the Print button to print the full report. 

 
Click the Done button to close the Verification window; the Schedule A Tab Screen is re-
displayed. 
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Sort Order 
 
This option can be used to set the order that the counties will be listed when you use any of the county 
selection options (Add/Delete Counties or View/Modify Existing Counties). This is especially useful if your 
company reports for a large number of counties. 
 
To change the default county sort order (state, subdivision, county name, type code), click the Sort Order 
button on the Schedule A Tab Screen, as shown below: 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sort Order - Sort Order Button 
 

The following Specify Sort Order box is displayed: 

 
Sort Order - Specify Sort Order Box 

 

Click on the Source Field name that you wish to use as the primary sorting method, then click the uppermost 
green arrow to move that Source Field into the “Sort Order” box. Continue selecting Source Field names to 
set your secondary sorting methods, clicking the green > button to move the Source Field to the Sort Order 
list. 
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- Click the green < button to move Source Fields from the Sort Order box back to the Source Field 
box. 

 
- Click the green >> button to move all Source Fields to the Sort Order box. 

 
- Click the green << button to move all Source Fields from the Sort Order box back to the Source 
Field box. 

 
After you have selected the Sort Order that you wish to retain, click the OK button. A message box appears, 
stating that your new sort order has been saved as the default sort order. 

 
Example: You can use the Sort Order option to change to the following default sort order: 

County Name, Type Code, Subdivision, State. 

Any time you select Add/Delete County or View/Modify Existing Counties, the counties listed will be sorted 
initially by county name.  You may have added multiple versions of the same county, if their type codes are 
different from each other.  In this instance, for the Sort Order shown above, counties with the same county 
name will then be sorted by type code.  You can change your default sort order anytime by using the Sort 
Order option again. 
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Print Form 
 

The Print Form function is used to print out a hard copy of the EIA-23L Form. This can be done as follows: 
 

1)  From the Main Menu Screen (click the Home tab if one of the other tabs is currently displayed), 
click the Print Form button. The following Print Selection Screen is displayed: 

 
 
 
 
 
 
 
 
Select Company 

to print 
 

 
 
 
 

Print Form - Print Selection Screen 
 

2)  On the left side of the Print Selection Screen, a list is displayed, showing all companies 
currently entered in RIGS.  Select the company for which you wish to print the form (as shown 
above). 

 
3) If the company’s filing is a resubmission, click the resubmission box (as shown above). If the 
resubmission box is checked, the printed Cover Sheet of the Form EIA-23L will show an X in the 
“Resubmission?” box, found in the top right corner of the form. 

 
4) Click the OK button to display the Print Preview screen, as shown on the following page. 
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Print Form - Print Preview Screen 
 

5) The Header Page is the default page displayed when the Print Preview Screen appears. You 
may view any of the parts of the form of the selected company by clicking the buttons along the 
left side of the screen: 

 
Header Page: The first two pages of the Form EIA-23L, showing Part I: Identification; 
Part II, Parent Company Identification; and Part III, Approval.  This page contains no oil 
and gas data, only company identification information. Note that, as of Report Year 
2016, the Header Page is now two pages long, and contains new data-entry boxes for 
Acquisitions and Subsidiaries/Affiliated Companies. 

 
Schedule A:  The next page of the Form EIA-23L, showing all county oil and gas data 
entered for the selected company. Click the Sort Options - Schedule A button (below the five 
Print Preview buttons) to set the sort order in which the counties will be displayed and printed. 

 
Schedule B:  This page(s) displays all footnotes entered in RIGS for the selected 
company. Click the Sort Options - Schedule B button to set the sort order in which the 
footnote information will be displayed and printed. 

 
Error Report:  The RIGS Error Report, which is the same validation report that is run by 
clicking the Verify Data button. 

 
State Totals: This page will display the totals for each state for which you have entered a county. 
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6) After previewing the forms as you wish on the screen, click the Print button (as shown 
below) to print the desired form(s). 

 
 
 
 

 
 

Click this 
icon to print 

 

Print Form - Print Button 
 

The following “Print Form” box is displayed. 
 

 
Print Form Box 

 

7) You may select any or all parts of the form to print. The default form to be printed is the form 
that is currently selected on the Print Preview Screen. However, you may select any or all forms 
to print from this screen, and you may also dictate which page numbers of each form that you 
wish to print, by typing in the desired page numbers in the “From” and “To” boxes. You may also 
change your printer setup by clicking the Printer Setup button. 

 
8)  After selecting the form(s) you wish to print, click the OK button. The form(s) that you selected 
(in # 7 above) is then sent to your printer. 

 
9) The Print Preview Screen is re-displayed. Click the Exit button in the upper left corner of the 
screen to return to the RIGS Main Menu. 
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Create Submission File 
 
After entering and validating all companies’ county data for which you are responsible, you must submit your 
final data to EIA via Secure File Transfer. Use RIGS to create a single file (containing all respondent 
companies’ data that you’ve added or updated) to submit electronically.  
 
To create a file to send via Secure File Transfer, follow these procedures: 
 

 1) From the Main Menu Screen, click the Create Submission File button. If you are attempting 
to submit data for more than one company, the following Select IDs to Submit box is displayed: 

 

Create Submission File - Select IDs 
 
 

NOTE: When you click the Create Submission File button, all county data you have entered in RIGS are run 
through the validation process. If a validation error is found, a “Data Failed” box appears, informing you 
that a validation check has discovered a potential error in your data. Follow the instructions in the “Data 
Failed” box to either correct the data or proceed with data submission (a validation report will automatically 
be printed if you elect to continue). See the “Verify Data” section for more details. 

 

 
 

2) This gives you the option of submitting companies separately, if you wish. From the left column of 
“Source IDs,” click on the Company ID(s) that you wish to submit—hold down the shift key to select 
multiple IDs—and click the top green arrow to move the selected companies into the IDs to Submit 
column. Move the IDs back and forth as necessary using the and arrows. To move all 
companies from one column to the other, use the and arrows.  

 

After filling the “IDs to Submit” field with the desired companies, click the OK button to continue the 
submission process. 
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The “Send Submission file to EIA” box is displayed: 
 

 
Create Submission File - Select Method 

 

3)  “Create a file to be submitted via Secure File Transfer” (SFT) is pre-selected when the “Send 
Submission file to EIA” box is displayed. If the filing you are sending is a resubmission, click the 
"Resubmission" box. 
 
4) Click the OK button. A message is displayed, describing the process for submitting via SFT.  

 
You have two options: a) Allow RIGS to try to open your web browser to the SFT page on EIA’s 
website, and commence the submission process from there; or b) Create the submission file and 
open your web browser on your own, copying the SFT web address and submitting from there. 
As the message states, the file containing your company data can be found at: 

 
C:\RIGS 2020\RIGSXXXXXX.DAT  

 
where C:\RIGS 2020 is the directory to which you installed RIGS; if you opted to change 
from the default installation directory during the install process, the file will be copied to 
whatever drive/directory to which RIGS was installed 

 
where XXXXXX is the company control number 

 
All companies that you have added to RIGS are found in a single file. 
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5) To allow RIGS to attempt to open your web browser to the EIA SFT site, click Yes when the 
following message is displayed. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Secure File Transfer – Dialog Box 
 
Your browser should open, and the SFT “Notice to Users” should be displayed, as shown 
below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Secure File Transfer – Web Site 
 

If you do not want RIGS to open your browser, click No on the SFT message box and print 
the instructions when the “Print” box is displayed. Open your browser and type in the SFT 
site address (https://signon.eia.doe.gov/upload/noticeoog.jsp); the “Notice to Users” is 
displayed, as shown above. 
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If you accept the conditions, click the Accept button. The main SFT screen is displayed, as 
shown below: 

 
Enter your contact information in the appropriate fields at the top of the screen. In the “File(s)” 
field, click the Browse button and locate the submission file that has been created by RIGS, 
located here: “C:\RIGS 2020\RIGSXXXXXX.DAT.”  

 
 

NOTE: The file name and location (on your hard drive or network drive, depending on where you installed 
RIGS) can be seen at the bottom of the RIGS Main Menu screen after you click Yes on the Secure File 
Transfer message box to open your browser. Use the Alt-Tab key combination to bring RIGS back to the 
foreground of your Desktop.  The filename is shown at the bottom of the screen as shown below:  

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you click on any Main Menu item, this message will revert back to showing the “Questions or 
problems?” phone number information. 
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When you are finished filling in all the required information, the SFT screen should look 
similar to this sample screen: 

 
Secure File Transfer – Filled In Screen 

 
Click the “Submit” button and your RIGS filing will be sent to EIA. A confirmation screen is 
displayed, alerting you that the submission was successful. 

 
Use the Alt-Tab key combination to switch back to RIGS. The Main Menu should be shown; you can exit the 
program; after you submit via SFT, your filing is now complete. 
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Import from File 
 
There are three types of File Importing available within RIGS. These are: 
 

1. Import last year’s data from the RIGS MS Access file (No longer available from this menu – 
please see “Initial Data Import from Last Year’s RIGS Submission File” on page 4 of this 
manual for instructions on how to import last year’s data via the RIGS Introduction screen) 

2. Import Schedule A data from an Excel file 
3. Import current year’s data from a text file 
 
 

Import Schedule A data from an Excel file 
 

This feature allows the user to import Schedule A data from an Excel spreadsheet, assuming that it is in the 
correct format. The format of the spreadsheet is shown in Appendix A, Import File Formats. You may 
choose to add the company or companies for which you are importing data before performing the Schedule 
A Excel import, or the import process will add the company/companies for you. Companies added via the 
Schedule A import will appear with no company identification information on "Cover Page Part I;" you must 
add that information (including company name) after the import. However, if the companies have already 
been added to RIGS, the Schedule A Excel import will simply add the county information from the spreadsheet 
to the existing company (or companies), as identified by the six-digit ID shown in the first column of the 
imported Excel spreadsheet. See Appendix A, “Import File Formats,” for more information about the specific 
format of the Excel file. 
 

To import Schedule A data into RIGS via an Excel spreadsheet, follow these procedures: 
 

1)  From the Main Menu Screen, click on the Import from File button. The following screen 
is displayed: 

 
Import from File - Import File Name 

 

2)  In the bottom right field, select “Schedule A Only from Excel (*.xls),” as shown above (its 
location on your hard drive will vary depending on where you store your RIGS Excel file). 

 
3)  Select the .xls file name that is to be imported (”2020RIGSImport.xls” in the sample above), 
and click the OK (or Open) button. A confirmation box is displayed, informing you that the 
import is complete. 
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4)  When you click Select Company from the Main Menu, you should see the ID number of the 
company for which you have imported data via Excel. Click on the company and you can add a 
company name on the “Cover Page Part I” tab. Your newly-imported data will appear in the 
“Schedule A” tab—click View/Modify Existing Companies to see your company data. 

 
Note: When performing the import, you may receive a message informing you that the data 
file you are attempting to import is invalid. Check the format of the data file you are using; it 
must match the format described in Appendix A, “Import File Formats.” 

 
Note: When prior year data are loaded into Columns A through H, incorrect values in Column H 
will be automatically recalculated as soon as you begin entering data into any of the data entry 
fields for that county. As you enter data into Columns B through G, Column H will adjust 
automatically, to ensure that the calculated Total Proved Reserves for the current year is correct. 

 
Import current year’s data from a text file 
 
Some companies that maintain a large amount of data keep their own EIA-23L data file up-to-date throughout 
the year in a text file. If you have such a file, you can load it into RIGS and avoid having to enter your data 
manually. The three types of file(s) to be imported must follow the format below: 
 

Schedule A Data:  These data are identified by the Record Type “A.” Data recorded as “County 
Data” on the Form EIA-23L are listed in this format. 

 
Company Data:  This file contains company identification information. These data are identified 
by the Record Type “C.” 

 
Footnote Data:  This file contains all footnotes entered. These data are identified by the Record 
Type “F.” 
 

For detailed descriptions of each of these three types of import files, see Appendix A, “Import File Layouts.” To 
view a Form EIA-23L facsimile, showing data cell names for company data files and Schedule A data 
files, see Appendix B, “Data Cell Codes.” 
 
Valid state codes, used in Schedule A data files and footnote data files, are listed in Appendix C, “State 
Abbreviation and Geographic Subdivision Codes.” 

 

To import any of the three data files containing current year data into RIGS, follow these procedures: 
 

1)  From the Main Menu Screen, click on the Import from File button. The following screen 
is displayed: 
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Import From File - Import File Name 

 
2)  In the bottom right field, select “Current Reporting Year (*.txt)” (its location on your hard 
drive depends on where you store your company data). 

 
3)  Select the file name that is to be imported, and click the OK (or Open) button. A confirmation 
box is displayed, informing you that the import is complete. 

 
Note: You may receive a message informing you that the data file you are attempting to import is 
invalid. Check the format of the data file you are using; it must match the format described in 
Appendix A, “Import File Formats.” 
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Help 
 

To get information about the various functions available within RIGS, you may click the Help button (in the 
upper right corner of the screen) at any time, as shown below. The Help button opens this “RIGS User’s 
Guide” in your Internet browser (http://www.eia.gov/survey/form/eia_23l/RIGS_Users_Guide.pdf).  

 
 

Help 
 

  
  
 
 
 
 
 
 

Exit 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Help / Exit 

 
 
 
 

Exit 
 
To exit RIGS, click on the Exit button in the upper right corner of the screen, as shown above. 
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Appendix A - Import File Layouts  - Part I: Current Year Text File Format 

There are three types of TXT records that can be imported into the EIA-23L system when importing current year’s data: 

1) Schedule A Data
2) Company Level Data
3) Footnote Data

Each is described below:

1) Schedule A Data: These data are identified by the Record Type “A”. Data recorded as “County Data” on the Form EIA-23L are listed in this
format. Each record consists of the following:

Field name Type of data # of 
characters 

Description Examples 

RECORD 
TYPE 

Alpha-numeric 1 Identifies the record as Schedule A data A 

COMPANY ID Numeric 6 EIA-supplied identification number 123456 

STATE CODE Alpha-numeric 2 Identifies the state to which data apply TX, AL 

SUBDIVISION 
CODE 

Alpha-numeric 2 Identifies the subdivision of the state to which data 
apply 

A blank shall be one of the choices on the list (some 
states do not have subdivisions). 

FIPS COUNTY 
CODE 

Numeric 3 Identifies the county to which data apply 995 shall represent the county for all federal offshore, 
state offshore is represented by 990. 

FIELD CODE Alpha-numeric 6 Identifies the field to which data apply. This field is no 
longer used as of Report Year 2016. These 6 
characters should be left blank in your import file. 

Should be six blank spaces in your import file. 

TYPE CODE Alpha-numeric 5 
(2 characters, 
followed by 3 
spaces) 

Identifies the type of reservoir. These include 
conventional, low permeability, shale, and unknown 

C, LP, SH, UN 

DATA CELL 
NAME 

Alpha-numeric 5 Identifies the data cell to which data apply. Data cell 
names are identified on the EIA-23L Form, included 
with this document. 

A_12A 

DATA CELL 
VALUE 

Alpha-numeric Up to 50 
(varies) 

Contains the data value for the data cell (identified on 
the Form EIA-23L Form) 

59872 

* The complete list of state subdivisions is found in the form instructions.
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2) Company Data: These data are identified by the Record Type “C.” Each record consists of the following:

Field name Type of data # of characters Description Examples 

RECORD TYPE Alpha-numeric 1 Identifies the record as Company data C 

COMPANY ID Numeric 6 EIA-supplied identification number 123456 

DATA CELL NAME Alpha-numeric 5 Identifies the data cell to which data 
apply.  Data cell names are identified on 
the EIA-23L Form, included with this 
document. 

I_1A 

DATA CELL VALUE Alpha-numeric Up to 50 (varies) Contains the data value for the data cell 
(identified on the Form EIA-23L Form) 

59872, Smith Gas 
Company, etc. 

Sample Company Data Record: 

NOTE: As shown in the sample records, all data fields must contain the exact number of characters 
described. If necessary, a blank space (or several blank spaces) must be inserted if a field value 
does not fill the required character length. For example, in the sample company data record 
above, note that there is a blank space at the end of the data cell name portions of the record, 
because those particular cell names (I_A, I_1A, and I_1B) are less than 5 characters long – the 
fourth and fifth characters must be filled with a blank space, where applicable. However, the final 
data field (in both Schedule A and company records), data cell value, need NOT have any blank 
spaces inserted, as it is at the end of the record and place holders are not necessary. 
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3) Footnote Data: These data are identified by the Record Type “F.” Each record consists of the following:

Field name Type of data # of 
characters 

Description Examples 

RECORD TYPE Alpha-numeric 1 Identifies the record as Footnote data 
F 

COMPANY ID Numeric 6 EIA-supplied identification number 123456 

STATE CODE Alpha-numeric 2 Identifies the state to which the footnote 
applies 

TX, AL 

SUBDIVISION CODE Alpha-numeric 2 Identifies the subdivision of the state to 
which the footnote applies 

A blank shall be one of the 
choices on the list (some states 
do not have subdivisions). 

COUNTY CODE Alpha-numeric 
3 

Identifies the county to which the footnote 
applies 101, 205 

FIELD CODE Numeric 6 Identifies the field to which the footnote 
applies. This field is no longer used, as of 
Report Year 2016. These 6 characters 
should be left blank in your import file. 

Should be blank 

TYPE CODE Alpha-numeric 2 
Identifies the type of reservoir. These 
include conventional, coal bed, low 
permeability, shale, and unknown 

C, CB, LP, SH, UN 

ITEM NUMBER Alpha-numeric 
2 Identifies the item number to which the 

footnote applies (corresponds to the item 
number found on the EIA-23L form). 

1, 2, 3, 4, 5,…15 

COLUMN DESIGNATION Alpha-numeric 
1 Identifies the column to which the footnote 

applies 
A, B, C, D, E, F, G, H 

FOOTNOTE Alpha-numeric 
Up to 255 Text of the footnote This data entry changed over 

20% in 2020 due to unusual 
increase in cost. 

Sample Footnote  Record: 
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Import File Layouts  - Part 2: Schedule A Spreadsheet  File Format 

The format that must be used in the Schedule A spreadsheet file in order to successfully import it into RIGS is as follows: 

The sample above shows only a portion of the complete file. All import data columns are described below. The column names correspond to 
the following fields in RIGS: 

ID: Company ID Number 
A_1: Two-character State abbreviation 
A_2: Subdivision Code 
A_3: County Code 
A_4:  NO LONGER USED 
A_5: Type Code 
Cnty: County Name 
A_6: Field, Play, or Prospect Name (Optional) 
A_7A:   Proved Non-Producing Reserves - Crude Oil 
A_7B:   Proved Non-Producing Reserves - Associated-Dissolved Gas 
A_7C:  Proved Non-Producing Reserves: Nonassociated Gas 
A_7D:  Proved Non-Producing Reserves: Lease Condensate 
A_8: Footnote Code 
A_9: Number of Producing Wells 
A_10:   Number of Wells Completed or Purchased 
A_11:   Number of Wells Abandoned or Sold 
A_12A: Total Proved Reserve: Crude Oil, as of Dec 31, 20xx 

The remaining fields are not shown in the sample file above. They correspond with fields 12A through 12H (Crude Oil) on Schedule A, followed by 13A 
through 13H (Associated-Dissolved Gas), then 14A through 14H (Nonassociated Gas), and 15A through 15H (Lease Condensate). 
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State Subdivision State Subdivision 
Abbreviation Code State Name and Geographic Subdivisions Abbreviation Code 

Form EIA-23L Reserves Information Gathering System (RIGS) User’s Guide  February 2021 

Appendix C - State Abbreviation and Geographic Subdivision Codes 

______________________________________________________________________________________________ 

State Name and Geographic Subdivisions 

Alabama - Onshore............................................. AL    Blank 
Alabama - State Offshore1................................. AL       99 
Alaska - North Onshore……………….............. AK N 
Alaska - North State Offshore1……………….. AK     88 
Alaska - South Onshore ..................................... AK S 
Alaska - South State Offshore1.........................  AK 99 
Arkansas ..............................................................  AR    Blank 
Arizona .................................................................  AZ   Blank 
California - Los Angeles Basin Onshore  ........ CA    1 
California - Coast Region Onshore..................  CA    2 
California - San Joaquin Basin Onshore .........   CA    3 
California - State Offshore1................................ CA    99 
Colorado ............................................................... CO   Blank 
Connecticut...........................................................  CT  Blank 
District of Columbia.............................................    DC   Blank 
Delaware...............................................................  DE Blank 
Federal Offshore - Atlantic 

   (Lower 48 East Coast).............................   FA   EC 
Federal Offshore - Alaska Arctic 

   (North of Bering Strait, Chuckchi, and 
 Beaufort Seas).................. .... .................    AK      AA 

Federal Offshore - Alaska Pacific 
  (South of Bering Strait, Bering Seas, and 
 Pacific) ................. ................. .................. AK      PA 

Federal Offshore - Gulf of Mexico 
  Eastern Planning Area…....................... FG EP 

Federal Offshore - Gulf of Mexico 
  Central Planning Area............................ FG CP 

Federal Offshore - Gulf of Mexico 
 Western Planning Area........................... FG WP 

Federal Offshore - Pacific  
 (Lower 48 West Coast)............................  FP   WC 

Florida - Onshore................................................    FL    Blank 
Florida - State Offshore1 .................................... FL      99 
Georgia ................................................................. GA   Blank 
Hawaii.................................................................... HI  Blank 
Iowa ....................................................................... IA    Blank 
Idaho......................................................................  ID Blank 
Illinois....................................................................  IL Blank 
Indiana..................................................................  IN Blank 
Kansas .................................................................  KS   Blank 
Kentucky ............................................................... KY   Blank 
Louisiana - North (Monroe and Shreveport  

   Districts)..................................................... LA     N 
Louisiana - South (Lafayette District)...............  LA     S 
Louisiana - State Offshore1...............................  LA     99 
Massachusetts ....................................................  MA   Blank 
Maryland ..............................................................  MD   Blank 
Maine....................................................................  ME    Blank 
Michigan............................................................... MI  Blank 

Minnesota...................................................... MN    Blank 
Missouri.......................................................... MO  Blank 
Mississippi - Onshore ................................. MS     Blank 
Mississippi - State Offshore1....................... MS     99 
Montana ......................................................... MT  Blank 
North Carolina ............................................... NC    Blank 
North Dakota ................................................. ND    Blank 
Nebraska........................................................ NE   Blank 
New Hampshire ........................................... NH    Blank 
New Jersey.................................................... NJ     Blank 
New Mexico - East .......................................  NM E 
New Mexico - West ...................................... NM   W 
Nevada........................................................... NV   Blank 
New York ....................................................... NY    Blank 
Ohio ................................................................ OH     Blank 
Oklahoma...................................................... OK  Blank 
Oregon ........................................................... OR     Blank 
Pennsylvania................................................ PA  Blank 
Rhode Island ................................................ RI   Blank 
South Carolina ............................................. SC    Blank 
South Dakota ................................................ SD    Blank 
Tennessee .....................................................  TN  Blank 
Texas - Railroad Commission District 1.... TX      1 
Texas - Railroad Commission District 2 

Onshore ................................................ TX 2 
Texas - Railroad Commission District 3 

Onshore ................................................ TX 3 
Texas - Railroad Commission District 4 

Onshore................................................. TX 4 
Texas - Railroad Commission District 5.... TX      5 
Texas - Railroad Commission District 6.... TX 6 
Texas - Railroad Commission District 7B. TX 7B 
Texas - Railroad Commission District 7C. TX 7C 
Texas - Railroad Commission District 8.... TX 8 
Texas - Railroad Commission District 8A. TX 8A 
Texas - Railroad Commission District 9.... TX 9 
Texas - Railroad Commission District 10 . TX 10 
Texas - State Offshore1 ................................ TX     99 
Utah ................................................................ UT   Blank 
Virginia ........................................................... VA    Blank 
Vermont..........................................................  VT Blank 
Washington................................................... WA   Blank 
Wisconsin ..................................................... WI Blank 
West Virginia................................................ WV    Blank 
Wyoming....................................................... WY    Blank 

Company Totals ......................................... ZZ  ZZ 

1  If you are not certain whether an offshore field lies in the Federal or the state domain, assume that it lies in the state domain and indicate this in a 
footnote in Schedule B. 




